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I

 

NTRODUCTION

 

This manual provides a reference for information about optimizing color printing with the 
Color Server and improving color quality and performance for all Color Server models. 
Specific features and options may vary, depending on the Color Server model at your site.

 

N

 

OTE

 

: 

 

The term “printer” is used throughout this manual to denote a supported printer or 
copier; the term “toner” refers to either toner or ink.

 

About this manual

 

This manual provides an overview of general color concepts, with a specific focus on color 
management for print output. It describes multiple scenarios (called 

 

workflows

 

) during 
which color information can be specified. It also provides application notes that explain how 
to print to the Color Server from popular Microsoft Windows and Apple Mac OS 
applications. 

Color terms and concepts, such as “

 

color space

 

,” “

 

spot color

 

,” “gamut,” and “source profile” 
appear in bold throughout this manual. If you are new to desktop color, or if any terms are 
unfamiliar, see Glossary, which is a separate document in this set.
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For additional information
This manual is one in a set of documentation that includes manuals for both users and system 
administrators. For a description of all the available documentation, see Welcome. All other 
manuals should be available at your site. Refer to them for more information as directed in 
this manual. 

For additional information about the topics discussed in this manual, see:

• Color Printing: For detailed information about the color printing options and settings 
available with your Color Server, as well as the ColorWise® color management system 
built into your Color Server.

• Print Options: For information about how to set the ColorWise print options.

For information about performing color management tasks and using ColorWise Pro Tools™, 
see ColorWise Pro Tools Help.

For general information about printing in color, see “Desktop Color Primer” on page 73 and 
the sources in the “Bibliography” on page 89.
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OVERVIEW OF COLOR MANAGEMENT CONCEPTS

To create successful color documents and presentations, you can take advantage of the features 
of color management software as they are implemented by the Color Server and on your 
desktop computer. This chapter is devoted to various elements of color management that 
contribute to predictable color results.

Understanding color management systems
A color management system (CMS) is a “translator” between the color space of the source 
device (for example, the monitor or a scanner) and the color space of the destination device 
(for example, the printer). It compares the color space in which the source image was created 
to the color space in which the job will be output, and adjusts the colors in the document to 
maintain consistency across different devices. A CMS typically uses a device-independent 
color space, such as CIELAB, as its intermediate color space. To perform its translation, a 
CMS needs information about the color space of the source image and the gamut of the 
printer. This information is provided through profiles, often created by the makers of the 
computer monitor or printer. The end product of a CMS conversion is a printed document 
or an image file in the gamut of a particular printer.

There has been progress toward standardization in the field of digital color management 
systems. Both the Windows and Mac OS operating systems support an industry standard 
format developed by the International Color Consortium (ICC). This ICC format is 
implemented on Windows computers and on Mac OS computers. Other software developers 
are also incorporating color management systems into high-end applications. 
The Color Server color management system, ColorWise, supports this standard profile 
format.
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How color management works

Before you can print a color document, the color data in it must be converted to the gamut of 
the printer. Whether performed by the Color Server or a host-based CMS, the process of 
converting color data for a printer is the same: the CMS interprets RGB image data according 
to a specified source profile and adjusts both RGB and CMYK data according to a specified 
output profile, also called a destination profile by some color management systems.

The source profile defines the RGB color space of the image’s source: characteristics such as 
the white point, gamma, and the type of phosphors used. The output profile defines the 
gamut of an output device, such as a printer. The Color Server (or the host-based CMS) uses 
a device-independent color space to translate between the source color space and the color 
space of the output device.

The Color Server allows you to specify default and override settings for the source color space 
information and the output profile information (see Color Printing). When you use these 
settings, there is no need to use the features of other color management systems. Your 
Color Server software includes ICC profiles for use with other color management systems, 
although conflicts may arise when the Color Server CMS is used in conjunction with a host 
CMS.

You can also use color management systems to adjust color data to the gamut of an output 
device other than the one to which you are printing. This process of simulating another 
output device is commonly used for proofing jobs that are printed on an offset press. For 
more information about the Color Server simulation feature, see Color Printing.

The type of print job and the final output device, Color Server or offset press, determines the 
workflow that provides the best results. For information about choosing workflows, see 
“Using Color Management Workflows” on page 13.

Input data Printed data or file

Color management system

Device-independent 
color space

Source 
profile

Output 
profile
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Using ColorWise and application color management
The Color Server color management system, ColorWise is designed to provide both casual 
and expert users the best color output for a variety of purposes. Several applications also 
provide their own color management system. This manual describes how to optimize print 
output using both ColorWise color management and application color management.

The Color Server can intelligently manage the printed appearance of RGB, CMYK, and spot 
colors. You can allow the Color Server to manage color for most color printing jobs without 
adjusting any settings.

A desktop (host-based) color management system uses ICC profiles to convert colors from 
one device gamut to another (see “Desktop Color Primer” on page 73). The color data is 
converted when it passes from one application to another or when the job is sent to the 
printer; thus, the processing occurs on your computer, as opposed to the Color Server.

Conventional color management systems typically address only color conversions, and they 
occupy your computer processor. When you use ColorWise, jobs leave your computer and are 
processed faster on the Color Server.

The advantages to ColorWise color management versus desktop (application) color 
management include the following:

• Relieving your computer from performing additional processing. Delaying color 
conversions until the color data reaches the Color Server frees your computer so that you 
can continue working, and color conversions on the Color Server are, in most cases, much 
faster than similar conversions on a host computer.

• Eliminating the potential for undesirable color management-related conflicts, such as 
iterative color conversions and inconsistent color. The Color Server applies global 
corrections to specific groups of RGB, CMYK, and spot colors to avoid such conflicts.

• Accepting RGB files in addition to larger CMYK files from applications, which minimizes 
network traffic and enables jobs to print faster.

ColorWise uses ICC profiles to convert colors to the device gamut or simulate other devices, 
such as an offset printing press. ColorWise manages color conversions for all users printing to 
the Color Server from Windows and Mac OS computers. It allows users to follow a simple 
workflow with minimal intervention using robust default settings, while giving advanced 
users the control and precision they need.
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Using ColorWise color management tools

Your Color Server user software includes several types of color reference pages that allow you 
to see the range of colors that can be printed on your printer. For predictable color, use the 
color reference pages when defining the colors in your document.

The resources available are as follows: 

RGB Color Reference: A Microsoft Word file and a Microsoft PowerPoint file that allow you 
to view the colors available in the standard palettes of office applications and to see how those 
colors print on the Color Server (see “Using color matching tools with office applications” on 
page 21).

CMYK Color Reference: An 11-page downloadable PostScript file of CMYK color patches (see 
“Using the CMYK Color Reference” on page 25). 

Process Simulation of PANTONE Solid Coated Colors: A 19-page downloadable PostScript 
file of color patches showing CMYK equivalents of PANTONE Coated colors. This file prints 
differently depending on the setting of the Spot Color Matching option (see “Using the 
PANTONE reference” on page 26). 

In addition, you can print RGB, CMY, and PANTONE color charts from the Color Server.
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USING COLOR MANAGEMENT WORKFLOWS

A workflow is the path a print job follows from creation to destination. In the workflow of 
any job, there are various points at which decisions are made about how to define, use, and 
translate color. The choices made, and the point at which they are made, impact the color 
output produced.

This chapter introduces issues with color management in specific desktop applications and 
discusses the interaction between those applications and ColorWise color management.

Understanding workflows
The term “workflow” is used to describe the path a job follows from its creation in a desktop 
application to final printed output. The Color Server supports a variety of workflows with 
different levels of complexity. There are several points at which color management can be 
performed on a job (see the illustration on page 14). The information provided at each step 
(for example, the type of color used) impacts the workflow of the job.

Always consider the complexity of the workflow. Every time colors are converted, 
performance and color accuracy are affected. A workflow with a minimum number of steps 
minimizes the risk of error.
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Application CMS: Off

Disable the color management options provided by the 
application to ensure that the Color Server receives color 
data properly and prints it accurately. For information, see 
the documentation that accompanies your application.

Select colors based on the desired output (see “Choosing 
colors” on page 16).

Select file format based on the desired output. EPS data is 
not manipulated.

Use ColorWise Color Management as described in this 
manual and Color Printing. 

Printer driver color options: Off

Do not use the color management options provided by the 
printer driver. For more information, see Print Options. 

Calibration

Device maintenance

Calibrate as described in Color Printing. Perform regular 
maintenance as recommended by the printer manufacturer. 
Use the paper stock, toner, and other materials 
recommended by the printer manufacturer.

R
G B

C M
Y K

DOCUMENT

Spot

SAVE AS (File Format)
EPS recommended

PRINT
Set ColorWise print options

Color Server

Optimal output
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Standard recommended workflow
The Color Server is highly optimized for the specific printer it supports. ColorWise addresses 
issues unique to your printer, including screens, individual toner response, interactions 
among toners, natural smoothness of blends, and the capability to render spot and custom 
colors. The Color Server distinguishes text and graphics from image elements, so that black 
channel information is preserved while parameters used for CMYK color separations are 
maintained.

The recommended standard color workflow uses ColorWise calibration and color 
management. The Color Server comes into play near the end of the color workflow. 

For this workflow:

• Bypass any color management in the applications and printer drivers.

This ensures that the colors you selected reach the Color Server and ColorWise in a 
usable form. Consider, however, that ColorWise fully supports color management from 
applications and printer drivers (see “Using ColorWise and application color 
management” on page 11).

• Set the CMYK Simulation Profile option in ColorWise to match the CMYK color space 
used in the application to select the colors. Any CMYK Simulation setting (except Match 
Copy, if available) applies calibration, so the response of the printer appears stable.

The recommended values for CMYK Simulation are SWOP in the U.S., Euroscale in 
Europe, and DIC in Japan—choices that reflect the color standard for each region. 
If colors have been selected specifically for your calibrated Color Server, set CMYK 
Simulation to None.

• Set other ColorWise print options as appropriate. For a list and descriptions of ColorWise 
print options that affect CMYK, RGB, spot, and other colors, see Color Printing.
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Choosing colors
When working with color materials, whether they are presentations, illustrations, 
or complicated page designs, you make aesthetic decisions about the colors you use. After you 
set a goal, you must make the best use of the capabilities of your Color Server to realize your 
design in print. Your color printing system becomes an ally in this creative process to the 
extent that results are predictable:

• If you designed a poster to print on the Color Server, you want the printed colors to match 
the design specification.

• If you are printing presentations on the Color Server, you want to preserve the vivid colors 
you see on your monitor.

• If you are working with color that is to be printed on an offset press, you want 
the Color Server output to match other prepress proofs or PANTONE color swatch 
books.

The colors that you define when creating a file in an application, and the color management 
tools within the application that you use, impact how the file is processed (workflow) and the 
final output you can expect. 

Use color management to control color output by performing the following tasks:

• Select a color model: Different types of applications use different color models. The color 
model you select, and whether or when data is converted from one color model to another, 
influences the final color output.

• Optimize for output type: The type of final output influences your color and application 
choices.

• Use color matching tools: The Color Server provides several tools to preview colors 
available on a device and define them within an application.
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Understanding color models

You can define colors in several different color models, most commonly RGB, CMYK, and 
the spot color matching system (such as PANTONE). Depending on the application you use, 
you may or may not have a choice of the color model. 

RGB colors are used when you take output from an RGB device such as a digital camera or a 
scanner. Another use of the RGB color model is for displaying colors on a monitor.

CMYK colors are what most printers use.

Spot colors, such as PANTONE, are special inks manufactured to run on an offset printing 
press. Spot colors can be simulated using CMYK toners (also known as process color inks). 
With the Spot Color Matching print option, you can determine how spot colors are printed 
at the Color Server:

• Spot Color Matching On uses color tables built in the Color Server to simulate the spot 
color with the closest equivalent available using the CMYK toners of the copier/printer 
connected to the Color Server. 

• Spot Color Matching Off instructs the Color Server to simulate the spot color using CMYK 
equivalents defined by the spot color manufacturer. These are the same CMYK values used 
by applications that include spot color libraries. This CMYK combination is then printed 
with the CMYK Simulation setting you choose, such as SWOP or DIC.

The color model used by your application determines the methods available for choosing 
colors, as well as the way color data is transmitted to the Color Server:

• Office applications, such as presentation software, spreadsheets, and word processing 
programs, use the RGB color model. They typically transmit only RGB data to the 
Color Server.

• Illustration applications use both the RGB and CMYK color models, but typically 
transmit only CMYK data to the Color Server.

• Pixel-editing applications use both the RGB and CMYK color models. They can transmit 
either RGB or CMYK data to the Color Server.
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Optimizing for output type

You can use the Color Server for on-demand color printing and for color proofing. 
On-demand color printing refers to those jobs for which the Color Server is the final print 
device. Printing jobs to the Color Server in preparation for printing on an offset press is 
referred to as color proofing. Both types of Color Server print jobs can use RGB, CMYK, and 
spot colors.

NOTE: The term “on-demand” applies to producing printed output when it is needed. You 
may be familiar with the term “short-run”, which usually applies to the volume of a printing 
task. Although these terms do not mean exactly the same thing, “on-demand” in this manual 
applies also to short-run printing scenarios. Because you can print as many pages as you need 
and can reprint jobs quickly, the Color Server performs equally well in either environment.

The type of printing you plan for the document, on-demand color printing on the 
Color Server versus color proofing for eventual printing on an offset press, determines the way 
you define colors, as well as the print option settings you choose.

• For on-demand color printing on the Color Server, use any application and define colors 
in either RGB or CMYK. If your application supports it, you can also choose colors from 
the PANTONE color library. Choose the appropriate settings for print options affecting 
color output (for descriptions of the print options, see Color Printing). 

• For color proofing, use a PostScript-defined color in CMYK or choose colors from color 
libraries, such as the PANTONE color library. Placed images can also be defined in RGB 
or CMYK. Choose the appropriate settings for print options affecting color output (see 
Color Printing).

NOTE: The Color Server allows you to use RGB or CMYK data when printing proofs for 
an offset press run. However, sending data to an imagesetter usually requires CMYK data.

Characteristics of on-demand jobs Characteristics of offset proofs

Bright, saturated colors are often desirable. Require the printed colors to match 
those from another set of CMYK 
printing conditions. 

Colors are achieved using the full range 
of colors available, referred to as the full 
gamut of the printer or, more simply, device 
CMYK. 

Colors that are specified for an offset press 
require CMYK simulation that is optimized 
for proofing on the printer.
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Maintaining color accuracy

For the colors you see on your monitor to match those on your printed output, they must go 
through color management, including precise calibration of your monitor and Color Server. 
If viewing colors on the monitor is critical, consider using a professional profiling software 
package and instrument, such as the EFI Color Profiler, to create a monitor profile. A monitor 
profile enables the application to compensate for the color behavior of the monitor when 
displaying images. As a result, colors previewed on the monitor match the colors more closely 
in your printed output. 

If you are not equipped or inclined to maintain accurate monitor color management, you can 
opt for an easier approach. Determine which is more important to you: printed colors or 
on-screen colors.

• If displayed colors are more important, trust your eyes and your monitor. Visually select 
colors on your monitor, but be aware that colors are optimized only for your monitor. 
When the document is opened on other monitors, the colors may look different. And even 
though printed colors may not match those on your monitor, they still print to the 
Color Server with good results.

• If printed colors are your priority, choose colors from printed samples. By using sample 
colors, you ensure your printed output remains consistent, regardless of how the 
colors appear on different monitors. Print the palette of available colors from business 
applications and select colors from the printed samples. Color reference files are included 
on the User Software CD. (For more information, see“Using color matching tools with 
office applications” on page 21 and “Using color matching tools with PostScript 
applications” on page 25.) You can also print color charts from the Color Server and select 
colors by name or number from the printed samples. Advanced applications allow you to 
define colors in the easier-to-control spot and CMYK color spaces. For more information 
about color selection, see “Choosing colors” on page 16.
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MANAGING COLOR IN OFFICE APPLICATIONS

The ColorWise color management system provides complete color management for jobs 
printed from office applications and other applications that do not generate PostScript. This 
chapter provides instructions for printing color documents from Graphics Device Interface 
(GDI) and QuickDraw applications, such as presentation, spreadsheet, and word processing 
applications. Use these instructions with the Microsoft Office applications.

Using office applications 
The Color Server must receive PostScript instructions to print an image or a document. Many 
applications do not create these PostScript instructions, relying on the printer driver to create 
them. Included in this category are most word processing, spreadsheet, and presentation 
graphics applications. These applications use Windows GDI to display and print when 
running Windows, and Apple QuickDraw to display and print when running Mac OS. 
The term “office applications” is used in this manual to refer to these GDI and QuickDraw 
applications.

All office applications handle color similarly, using the same RGB color model used for the 
color monitor. Most office applications allow you to choose colors from a palette of 
preselected colors. Some allow you to add new colors to the palette using a color picker. 
Although some applications allow you to specify color using the CMY, HSL, and HSV color 
models, these applications always send RGB color data to the Color Server. 
(An exception to this is a CMYK EPS file placed in the document, which is sent as 
CMYK data.)

When working with color in office applications, consider the following:

• The range of colors that can be displayed in RGB on your monitor is much larger than the 
range of colors that can be printed on your printer. When you print the document, 
out-of-gamut RGB colors are mapped to the colors your printer can produce.

• Office applications send only RGB data to the Color Server. You control the rendering 
style of the color conversion with your selection of a CRD.

Each CRD uses a different color rendering style and has a different way of mapping 
unprintable colors to the color gamut of your printer. For more information about color 
rendering styles, see Color Printing. 
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Using color matching tools with office applications

Your Color Server user software includes two RGB color reference pages, a Microsoft Word 
file and a Microsoft PowerPoint file. You can print these files using different CRDs to see how 
the colors appear when printed to the Color Server. For best results, print the color reference 
page using the same print options you plan to use for your final document. Select the colors 
you want to use from the printed version of the RGB color reference page and use those colors 
in your document.

RGB Color Reference 
(Microsoft PowerPoint)
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Working with office applications
Before printing from these applications, make sure the appropriate printer driver and the 
Color Server PPD are installed on your computer, as described in Printing from Windows or 
Printing from Mac OS. 

Defining colors

Office applications use the RGB color model. The only way to use CMYK or PANTONE 
colors is to define them in EPS format files with an illustration or page layout application, 
and then place these files in Microsoft Office documents. Colors in EPS files are preserved 
until they reach the Color Server (assuming no PostScript Color Management information 
was included).

Office applications use low resolution to display EPS files, but the EPS images are printed at 
full resolution. In general, use EPS files only when RGB colors are impractical in your specific 
workflow. EPS files are useful when using large or complex images that must be printed at full 
resolution or exceed the memory allocation of some office applications.

Working with imported files

Your application may allow you to import a variety of file formats. If you encounter  printing 
problems when using other imported file formats, such as TIFF and PICT, EPS files are 
recommended.

NOTE: If you cannot import EPS elements, it may be necessary to perform a “custom install” 
of your office applications.

Even when there are no user-defined color management options within office applications, 
color conversions do occur when you import images or page elements that were not defined in 
RGB. To avoid such conversions with imported files, use the EPS file format for non-RGB 
artwork that is to be imported into office applications.

All RGB images placed in a document are affected by the settings you choose for the RGB 
Source and Rendering Style print options.

Mixing imported image types (Advanced color management)

If you place multiple RGB images, mixed non-photographic and photographic, into an office 
application file, a single CRD may not optimize output for all the images. In this case, 
you can have the photographic images to bypass the CRD altogether. To accomplish this, 
open the photographic image in CMYK mode with a pixel-editing application, such as 
Photoshop, and perform color correction. Save the image as a Photoshop EPS and import it 
into the document. 
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Selecting options when printing

There are few differences among office applications with regard to Color Server printing. To 
specify print options and color management settings, follow the instructions in Color Printing. 
To specify these options, you must use a PostScript Level 2 (or later) printer driver, such as an 
Adobe PostScript Printer Driver.

Because office applications send RGB data to the Color Server, your choice of RGB Source 
and Rendering Style settings are important. Specify the appropriate CRD for the desired color 
effect (see Color Printing).

Output profiles

All color data in the job is affected by the output profile on the Color Server. This profile may 
be the one designed for your device and shipped with the Color Server, or it may be a custom 
profile created at your site (see Color Printing). If necessary, print the Test Page to see which 
profile is the active default on the Color Server. 

Ensuring color accuracy when you save a file

Take the following steps to ensure color accuracy:

• When saving EPS files, do not include PostScript Color Management information. This 
minimizes the risk of conflicting data and multiple color conversions. PostScript Color 
Management causes your CMYK and RGB colors to be interpreted by the Color Server as 
though they were supplied in the Lab color space and, as a result, processed by CRDs, 
rather than your simulation settings.

• Include ICC color information in files. ColorWise does not conflict with this information, 
and such data is useful for identifying the specific color space used by your files.

• Do not include halftone and transfer functions.

• Turn off color management in the printer driver. 

On Windows computers, if the printer driver offers Image Color Matching options, select 
Printer Image Color Matching.

On Mac OS computers, set the printer driver to include no color management commands 
at print time (see Color Printing). 
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MANAGING COLOR IN POSTSCRIPT APPLICATIONS

This chapter provides guidelines for using applications that have the ability to write their own 
PostScript, such as some page layout, illustration, and pixel-editing applications. For 
information about using specific applications, see “Managing Color in Adobe Photoshop” on 
page 33, “Managing Color in Page Layout Applications” on page 44, or “Managing Color in 
Illustration Applications” on page 59. 

Working with PostScript applications
Most applications used for illustration, pixel editing, and page layout can create the 
PostScript information they send to a PostScript printer or save in PostScript files. Illustrator, 
Photoshop, PageMaker, QuarkXPress, and Macromedia FreeHand are all PostScript 
applications.

PostScript applications work with color in many different ways. Most allow you to choose 
process colors (by entering percentages for cyan, magenta, yellow, and black), as well as 
named colors from a spot color system, such as PANTONE. When you print composites, 
these applications send process-color equivalents for named spot colors to the Color Server. 
In some applications, you can also choose colors using the RGB, HSB, HSL, or other color 
models.

Generally, PostScript applications send color information to the Color Server as CMYK data. 
An exception to this is an RGB image placed in a document, which is sent directly to the 
Color Server (unless you specify special color management settings in the application). In 
addition, some PostScript applications that allow you to define colors in RGB or other color 
models also send data to the Color Server in those color spaces.

Color controls in PostScript applications are typically designed for printing on an offset press, 
and some adjustments are required for printing to the Color Server. Displayed versions of 
colors you choose in these applications may not match Color Server output exactly, and 
named colors may not print accurately on the Color Server, since these colors typically require 
custom inks. 
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Using color matching tools with PostScript applications
With PostScript applications, you can work with colors created with any of the color models 
supported by the application. All PostScript applications support CMYK. Some also support 
RGB and other color models based on monitor display values. PostScript applications also 
allow you to choose named colors using one or more color libraries, such as PANTONE (see 
page 26).

Using swatch color matching tools

Your Color Server user software includes several color reference pages (see page 12). By 
choosing colors from these reference pages, you ensure that you print the same color from 
your device. For best results, calibrate the Color Server before printing the reference pages. 

NOTE: We highly recommend that you use swatch color matching to ensure predictable color 
printing results with the Color Server or match your Color Server output to colors produced 
by other printers. 

NOTE: Swatch color matching does not match monitor colors to printed colors. For this, you 
must use a color management system and calibrate your monitor.

Using the CMYK Color Reference

Use the CMYK Color Reference included with your Color Server user software to see how 
various cyan, magenta, yellow, and black combinations look when printed on your printer.

To print the CMYK Color Reference, download the file to the Color Server. The printed 
pages display groups of color patches in graduated combinations of yellow, magenta, and 
cyan, and smaller patches that include 25%, 50%, and 75% black. Refer to these pages to 
pick colors and specify process color values in your application. For the location of the file on 
the User Software CD, see Printing from Windows or Printing from Mac OS.
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Using the PANTONE reference

Use this reference (Process Simulation of PANTONE Solid Coated Colors) included with 
your Color Server user software to help ensure predictable results with colors chosen from the 
PANTONE color library. 

The information printed by this reference depends on the Spot Color Matching setting. 

Spot Color Matching On prints swatches that simulate the spot color with the closest equivalent 
available using the CMYK toners of the copier/printer connected to the Color Server. The 
equivalent PANTONE color name/number is printed below each swatch.

Spot Color Matching Off prints swatches of the CMYK equivalents of PANTONE colors as 
defined by PANTONE. (These are the same CMYK values defined in applications that 
include PANTONE libraries.) The CMYK values used to produce the color, as well as 
the PANTONE color name/number, are printed below each swatch.

To print the reference, download the file to the Color Server. For the location of the file on 
the User Software CD, see Printing from Windows or Printing from Mac OS. If the default Spot 
Color Matching setting on the Color Server is not the setting you want to use for printing the 
PANTONE colors, download the file to the Hold queue, and then override the Spot Color 
Matching setting using a job management utility, such as Command WorkStation. 

For more information about using Command WorkStation, see the Command WorkStation 
Help.
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Defining colors
The methods and options available for defining colors depend on the type of PostScript 
application that you are using.

Color 
model

Application 
type

Color definition notes

CYMK Photoshop Choose colors in Photoshop with various color models, including 
HSB, CIE Lab, RGB, and CMYK. 

Page layout 
application

Page layout applications generally use the CMYK color model. Some 
allow you to define colors with other color models and may be able 
to send that data to the Color Server in those other color models. 
Generally, however, CRDs (which affect only RGB data) do not 
affect colors defined in page layout applications. 

For predictable results with CMYK colors, use the CMYK Color 
Reference when defining colors in page layout applications (see 
“Using color matching tools with PostScript applications” on 
page 25). 

Illustration 
application

All illustration applications use the CMYK color model. Although 
you may be allowed to define colors using other color models, these 
applications generally send only CMYK data to the Color Server. 

For predictable results with CMYK colors, use the CMYK Color 
Reference pages when defining colors (see “Using color matching 
tools with PostScript applications” on page 25).

Different versions of Illustrator support color models slightly 
differently (see “Note about color models in Adobe Illustrator” on 
page 60).
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RGB Photoshop Choose colors in Photoshop with various color models, including 
HSB, CIE Lab, RGB, and CMYK. 

Page layout 
application

If the application allows you to define colors in RGB, determine 
whether it converts the RGB data to CMYK before sending it to the 
Color Server. If it does, this will determine which ColorWise print 
options affect your job. 

For example, if the application converts RGB black (defined in the 
document as R0%, G0%, B0%) to four-color CMYK black when it 
sends the job to the Color Server, the option you select for the Pure 
Black Text/Graphics print option has no effect when you print the 
job.

Illustration 
application

If you define colors in RGB and print directly from the application, 
the application converts the RGB data to CMYK before sending it 
to the Color Server. This conversion by the application determines 
which ColorWise print options affect your job. 

For example, if the application converts RGB black (defined in the 
document as R0%, G0%, B0%) to four-color CMYK black when it 
sends the job to the Color Server, the option you select for the Pure 
Black Text/Graphics print option has no effect when you print the 
job.

Spot 
Colors

Photoshop Choose named colors from the PANTONE color library (see 
“Using the PANTONE reference” on page 26). For best results, use 
the color definition methods described in “Using swatch color 
matching tools” on page 25.

Page layout 
application

Illustration 
application

Color 
model

Application 
type

Color definition notes
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Working with imported images 
You can import images into documents created in illustration applications (such as Illustrator) 
and page layout applications (such as QuarkXPress). The recommended formats for images 
imported into page layout documents are EPS (or EPSF) and TIFF. If you encounter a 
problem using a TIFF format image, use the EPS file format. Support for importing other file 
formats may be provided by individual applications. 

All RGB images placed in a document are affected by the RGB Source and Rendering Style 
settings. The ColorWise color management system applies the specified RGB Source setting 
to all RGB data and then uses the specified Rendering Style (CRD) to perform a color 
conversion. An exception to this occurs if you assign ICC profiles to RGB images using the 
application’s color management tools (see the following section). In this case, the application 
performs the color conversion of the image and sends CMYK data to the Color Server.

NOTE: To take advantage of RGB Source and Rendering Style settings for images imported 
into QuarkXPress, save images in the EPS format or use the Quark PrintRGB XTension, 
which outputs RGB TIFF image files without converting them to CMYK.

Mixing image types (Advanced color management)

If you place multiple RGB images, mixed non-photographic and photographic, into a file, 
a single CRD may not optimize output for all the images. In this case, you can have the 
photographic images to bypass the CRD altogether. To accomplish this, separate the image 
to CMYK data with a pixel-editing application, such as Photoshop, and perform color 
correction. Save the file as EPS or TIFF format and import it into the document. 

If your application supports this feature, you can save the RGB image in TIFF format and 
assign it an ICC profile and rendering intent when you import it into the document.
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Using CMYK simulations 

You can specify a CMYK Simulation profile and a CMYK simulation method for a job 
using the CMYK Simulation Profile and CMYK Simulation Method print options (see Color 
Printing). The CMYK Simulation setting affects all CMYK color data sent by the page layout 
or illustration application. It can also affect RGB data sent to a page layout application if RGB 
Separation is set to Simulation.

• If the document contains CMYK graphics that were separated for an offset press standard, 
apply the corresponding CMYK Simulation setting. For example, for graphics separated 
for SWOP, choose SWOP as the CMYK Simulation setting. 

If you print separations to the Color Server and choose to use the Combine Separations 
feature in conjunction with Full Simulation, the result may not match that of the same 
page printed as composite.

• If the document contains CMYK graphics that were separated according to the color 
characteristics of a custom ICC profile (not a press standard profile), specify the 
corresponding profile as the CMYK Simulation Profile setting on the Color Server. 

For more information on downloading CMYK Simulation profiles to the Color Server with 
ColorWise Pro Tools, see Color Printing.
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Using application-defined halftone screens
If your site has installed the Fiery Graphic Arts Package (not available for all Color Server 
models), you can define halftone screens from several PostScript applications and use them 
when printing. The results vary depending on the application.

To define a halftone screen, use the application to adjust the Frequency and Angle values of 
the halftone screen. For applications that use the Color Server default (InDesign, FreeHand, 
QuarkXPress, and Illustrator 10), the ink dots are round. For applications that define 
their own shape and do not use the Color Server default (PageMaker, Photoshop, and 
Illustrator 9),the halftone dots may be a different shape. When you print the job, choose 
Application Defined for the Halftone Screen print option.

The Frequency and Angle settings in the Application Defined halftone screen are used 
regardless of whether the setting for Combine Separations is set to On or Off. For special 
instructions for printing separations with Photoshop, see “Selecting options when printing” 
on page 39.

NOTE: In general, using halftone screens is not recommended because the print output will 
have visible dots of toner rather than smooth blends. Use halftone screens only when 
necessary to achieve a specific style of print output.
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Ensuring color accuracy when you save a file
To ensure color accuracy, take the following steps:

• When saving EPS files, do not include PostScript Color Management information. This 
minimizes the risk of conflicting data and multiple color conversions. PostScript Color 
Management causes your CMYK and RGB colors to be interpreted by the Color Server as 
though they were supplied in the Lab color space and, as a result, processed by CRDs, 
rather than your simulation settings.

• Include ICC color information in files. ColorWise does not conflict with this information, 
and such data is useful for identifying the specific color space used by your files.

• Do not include halftone and transfer functions.

• Turn off color management in the printer driver. 

On Windows computers, if the printer driver offers Image Color Matching options, select 
Printer Image Color Matching.

On Mac OS computers, set the printer driver to include no color management commands 
at print time (see Color Printing). 
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MANAGING COLOR IN ADOBE PHOTOSHOP

This chapter covers features of Adobe Photoshop versions 6.x and 7.x for Windows and 
Mac OS. The illustrations show Mac OS dialog boxes, but the information and instructions 
apply equally to the Windows version of Photoshop.

Because Photoshop uses a sophisticated color management system, you should perform some 
color management tasks before you use Photoshop. 

Loading monitor settings files and ICC device profiles in 
Photoshop 6.x/7.x

After you have installed the Efirgb.icc monitor settings file and the ICC device profile for the 
Color Server, they can be loaded at the same time in Photoshop 6.x/7.x.

TO LOAD THE MONITOR SETTINGS FILE AND ICC DEVICE PROFILE IN PHOTOSHOP 6.X/7.X

1 Start Photoshop.

2 Choose Color Settings from the Edit menu and select Advanced Mode in the Color Settings 
dialog box.

3 Choose EFI RGB from the RGB menu.

4 Choose the profile that corresponds to the Color Server from the CMYK menu.

The Color Server ICC profile is provided as the factory default.

Additionally, the Color Server ICC profile is provided on the User Software CD. This is 
designed for more faithful reproduction of RGB objects using black toner only when R, G, 
and B have the same ratio. The profile is suitable for business documents that include 
black-and-white tables and text. It will have no effect on documents that have color 
gradation patterns (patterns which include black) or color photographic images.

5 Click OK.

For more information, see your application’s documentation. 
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Specifying color settings
The following sections outline the recommended color settings for Photoshop in a 
Color Server workflow. These color settings include:

Working Spaces: Default color spaces to use when working with RGB and CMYK 
documents. ICC color profiles describe the gamut and color characteristics of these working 
spaces.

Color Management Policies: Instructions that tell Photoshop what to do when it encounters 
color data from a color space other than the specified working space.

Configuring Photoshop color settings 

Photoshop uses a sophisticated color management system that handles document colors for a 
variety of color-managed workflows. By customizing color settings, you specify the amount of 
color management you want to use while working in Photoshop. 

TO SPECIFY COLOR SETTINGS FOR PHOTOSHOP

1 Choose Color Settings from the Edit menu.

The Color Settings dialog box appears.

2 Select Advanced Mode.

In Advanced Mode, a more extensive list of options is displayed.
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3 Choose the desired working space profile for each color mode in the 
Working Spaces area.

A working space specifies the color profile for documents that have no color profile 
associations or for documents that are newly created. It also defines color space of a document 
converted to RGB, CMYK, or Grayscale color modes, and for spot colors in a document.

Choose an appropriate ICC profile to embed when saving a file for each color space. Use the 
following guidelines for specifying working spaces:

• For RGB, choose the profile for the default RGB color space used by the Color Server. In 
most cases, this is EFIRGB. (For information about installing the EFIRGB profile, see 
“Loading monitor settings files and ICC device profiles in Photoshop 6.x/7.x” on 
page 33.) Consider RGB if you usually view images on a generic computer monitor or rely 
on a Windows operating system to manage color on your monitor. If you choose sRGB as 
a working space, you must print with the ColorWise RGB Source option set to sRGB. 
New RGB documents you create in Photoshop will use this working space.

NOTE: EFIRGB is set as the default RGB source color space on the Color Server. No matter 
what RGB space you select, make sure it is available on the Color Server. For more 
information about downloading RGB Source profiles to the Color Server, see Color Printing.

• For CMYK, choose a profile that describes your target press (such as SWOP) if you are a 
prepress user. If you are an user who prints final output, choose an output profile that 
describes the device connected to the Color Server. To use a device-specific output profile, 
you must first upload the profile from the Color Server to your computer (see Color 
Printing). New CMYK documents you create in Photoshop will use the specified working 
space.

• For guidelines on specifying Gray and Spot working spaces, see your Photoshop 
documentation.

4 In the Color Management Policies area, choose policies for handling documents without 
embedded profiles or with embedded profiles that differ from the working space.

Unless you are an advanced color user, choose Off from the RGB, CMYK, and Gray menus. 
If you specify a color management policy and open a document in an environment with a 
different working space than the one in which it was created, you may encounter problems. 
The profile embedded in a document may be overwritten if it differs from the specified 
working space (although the numeric color values in the document are preserved).
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5 If you do not choose Off for the Color Management Policies, select the following: 

Profile Mismatches: Ask When Opening, Ask When Pasting

Missing Profiles: Ask When Opening.

This option displays an alert message that allows you to override the specified policy behavior 
(Off ) when opening documents or importing color data.

This is recommended so that you are notified before any application color management is 
applied.

6 In the Conversion Options area, specify settings for converting between color spaces.

Choose Adobe (ACE) from the Engine menu to use the built-in color management engine 
for Photoshop.

Choose a rendering intent from the Intent menu that optimizes the color quality of the 
conversion. For guidelines on choosing the rendering intent, see your Photoshop 
documentation. 

Select Use Black Point Compensation and Use Dither (8-bit/channel images) to optimize the 
quality of color conversions.

7 Clear the Desaturate Monitor Colors By and Blend RGB Colors Using Gamma options in the 
Advanced Controls area.

Clearing these options helps to ensure a match between your monitor display and the 
printed output.

8 Click Save to save the current group of color settings.

The Save dialog box appears. 

9 Name the settings file, accept the default saved location, and click Save.

You can switch to your saved settings at any time by choosing the group name from the 
Settings menu at the top of the Color Settings dialog box.
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Saving files from Photoshop
Before saving a file from Photoshop, perform any necessary rotating, cropping, and resizing. 
This speeds processing when printing from the application in which the image is placed.

When saving a document from Photoshop 6.x, you have the option to embed a color profile 
in the document. If you are sending the document to the Color Server, we recommend that 
you disable this option.

Choosing a file format

We recommend that you use EPS or TIFF file formats to save RGB images that will be 
imported into other documents and printed to the Color Server. You can import EPS and 
TIFF files into virtually all page layout applications.

NOTE: Although TIFF files generally display better when imported into other applications, 
their color and resolution characteristics may be altered by the application into which they are 
imported. EPS files are not modified by the application into which they are imported.

NOTE: In the following procedures, only Photoshop 7.x (Mac OS version) dialog boxes are 
shown. When applicable, differences between versions 7.x and 6.x, and the Windows and 
Mac OS versions of Photoshop are noted.

TO SAVE A DOCUMENT FROM PHOTOSHOP

1 Choose Save As from the File menu.

The Save As dialog box appears.

2 Specify settings in the Save As dialog box.

• Specify a name, file format, and location for the document.

• Clear the Embed Color Profile option (Mac OS) or ICC Profile option (Windows).
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3 Click Save.

If you chose Photoshop EPS as the format, the EPS Options dialog box appears.

4 Specify EPS options and click OK.

• Choose a TIFF preview option. A TIFF preview is compatible with both Windows and 
Mac OS computers.

• Do not select the PostScript Color Management option. For more information about 
PostScript Color Management, see the following section. 

• Do not select Include Transfer Function or Include Halftone Screen.

NOTE: If you choose JPEG encoding, save a backup of the original image saved with binary 
encoding until you see the printed results of the JPEG file. Occasionally, the compression 
used for JPEG encoding produces unwanted artifacts. If you see unexpected results in the 
printed output of a JPEG file, revert to a binary version.

If you experience problems printing the document in which you placed the image, substitute 
an ASCII version of the same image and reprint the document. Binary encoding is much 
more compact than ASCII encoding, but occasionally causes printing problems with some 
system configurations.
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Selecting options when printing
You can print RGB or CMYK images from Photoshop. 

• When you print an RGB image, you choose whether the conversion to CMYK is 
performed by the Color Server (using a CRD), PostScript (using PostScript Color 
Management), or Photoshop built-in color management.

• When you print a CMYK graphic, you can print composites or color separations.

NOTE: Make sure that the Color Server Combine Separations print option is set to Off. To 
print separations, use the Separation option in the Photoshop pane of the print dialog box. 
For instructions, see your Photoshop documentation.

TO PRINT IMAGES FROM PHOTOSHOP 7.X 

1 Choose Print with Preview from the File menu.

The Print dialog box appears.

2 Select Show More Options.

3 Select Output.

4 Choose an Encoding method. 

NOTE: If you choose JPEG encoding, save a backup of the original image with 
binary encoding until you see the printed results of the JPEG file. Occasionally, the 
compression used for JPEG encoding produces unwanted artifacts. If you see unexpected 
results in the printed output of a JPEG file, revert to the binary version.
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5 Select Color Management.

6 Choose Same as Source from the Profile menu to specify the color space for printing the 
image.

Any other setting causes Photoshop to convert image data to that color space before sending it 
to the Color Server.

7 Click Print.

TO PRINT IMAGES FROM PHOTOSHOP 6.X

1 Choose Print from the File menu.

The Print dialog box appears.
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2 Choose the Color Server from the Printer menu, and then choose Adobe Photoshop from the 
menu beneath the Printer menu.

3 Choose an Encoding method. 

NOTE: If you choose JPEG encoding, save a backup of the original image with 
binary encoding until you see the printed results of the JPEG file. Occasionally, the 
compression used for JPEG encoding produces unwanted artifacts. If you see unexpected 
results in the printed output of a JPEG file, revert to the binary version.

4 Choose Same as Source from the Profile menu to specify the color space for printing 
the image.

Any other setting causes Photoshop to convert image data to that color space before sending it 
to the Color Server.

5 Click Print.

Advanced tips for using PostScript color management

Use the following information to implement alternative, more complex, color workflows with 
Photoshop.

NOTE: To use PostScript color management with Photoshop 6.x, choose PostScript Color 
Management from the Profile menu in the Photoshop pane of the printer driver.

Saving EPS documents with PostScript Color Management

Selecting the PostScript Color Management option when saving either a CMYK or RGB EPS 
file prompts Photoshop to embed PostScript color information—which is independent of 
ICC profiles—in the resulting document. This information is intended for PostScript devices 
like the Color Server.

Printing RGB EPS files saved with PostScript Color Management

When you print an RGB EPS file that contains an embedded profile to the Color Server, you 
can use the working space information from the embedded RGB profile as an RGB source 
definition for Color Server CRDs. To use this source color space information from the 
embedded profile with Color Server CRDs, choose None as the ColorWise RGB Source 
when you print. This applies when you print directly from Photoshop or when the same RGB 
EPS file is output from another application.

To override the embedded profile in an EPS file using an RGB Source definition made 
available by the Color Server, choose anything except None as the Color Server RGB Source 
Profile.
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Printing RGB images with Photoshop PostScript Color Management 

If you select an RGB color space and decide to use PostScript Color Management, 
Photoshop sends RGB data to the Color Server along with PostScript color information 
defining this RGB color space. When you select PostScript Color Management, a CRD is 
used to perform color conversions to CMYK.

NOTE: The included RGB source color space information is overridden by the ColorWise 
RGB Source option unless it is set to None. The ColorWise Rendering Style option specified 
takes effect if the ColorWise RGB Source Profile option is set to None.

For fastest print times, choose JPEG encoding, but inspect printed output carefully 
for unwanted artifacts that may appear as a result of JPEG compression. If you see unexpected 
results in the printed output, reprint the job using Binary or ASCII encoding.

Printing CMYK EPS files saved with PostScript Color Management

If you select the Photoshop PostScript Color Management option when you save a CMYK 
EPS image, Photoshop embeds PostScript color information that defines the CMYK source 
color space of the image. When you print a CMYK EPS file that contains PostScript color 
information to the Color Server, CRDs are used instead of ColorWise CMYK Simulation 
and Simulation Method settings. Choose the appropriate setting for the Rendering Style 
option.
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Printing CMYK graphics with Photoshop PostScript Color Management

If you select a CMYK color space and decide to use PostScript Color Management, 
Photoshop sends CMYK data to the Color Server along with PostScript color information 
defining this CMYK color space. When you select PostScript Color Management, a CRD is 
used to perform color conversions to the CMYK color space of the Color Server.

The destination color space for the CRDs is determined by the RGB Separation print option. 
If RGB Separation is set to Simulation, the CMYK graphic is printed according to all 
specified CMYK Simulation Profile and CMYK Simulation Method settings. If RGB 
Separation is set to Output, the CMYK graphic is converted to the CMYK color space of the 
selected output profile.

Setting the Color Server print option Spot Color Matching to On has an effect only if you use 
the Photoshop Multi-Channel feature to define spot channels and then save the image in EPS 
format and open it in another application. For more information see your Photoshop 
documentation.

Photoshop converts spot colors to CMYK values when you work in CMYK mode.

• If the graphic was separated for an offset press standard, apply the corresponding CMYK 
Simulation setting. For example, if the graphic is separated for SWOP, choose SWOP as 
the CMYK Simulation setting. 

• If Photoshop is configured for a custom separation using a ICC profile, choose the 
corresponding profile for the ColorWise CMYK Simulation option. 

The previous custom simulation setting requires that the same profile used for separation in 
Photoshop also resides on the Color Server. For more information about downloading 
CMYK Simulation profiles to the Color Server with ColorWise Pro Tools, see Color Printing.
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MANAGING COLOR IN PAGE LAYOUT APPLICATIONS

This chapter provides instructions for printing color documents from Adobe InDesign, 
Adobe PageMaker, and QuarkXPress.

Before printing from these applications, make sure the appropriate printer driver and the 
Color Server PostScript printer description file (PPD) are installed on your computer, as 
described in Printing from Windows or Printing from Mac OS. 

Adobe InDesign 2.0.1 and 1.5.2
The following sections outline the recommended settings for using Adobe InDesign with the 
Color Server.

InDesign color settings

When using ColorWise color management, turn off the InDesign color management features.
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TO DISABLE INDESIGN 2.0.1 COLOR MANAGEMENT

1 Choose Color Settings > Document Color Settings from the Edit menu.

2 Clear the Enable Color Management option and click OK.

TO DISABLE INDESIGN 1.52 COLOR MANAGEMENT

1 Choose Color Settings > Document Color Settings from the Edit menu.

2 Clear the Enable Color Management option and click OK.
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Importing images

All RGB images placed in a document, except for RGB TIFF images, are affected by your 
RGB Source and Rendering Style settings. For best results with placed images, use the 
instructions in “Working with imported images” on page 29.

NOTE: InDesign converts placed RGB TIFF images to CMYK.

Disable InDesign color management when placing images in a document.

TO DISABLE INDESIGN 2.0.1 COLOR MANAGEMENT WHEN IMPORTING IMAGES

1 Choose Place from the File menu.

The Place dialog box appears.

2 Select the Show Import Options option.

3 Select the file that you want to import and click Open.

4 Choose Color Settings from the option menu. Make sure that the Enable Color Management 
option is cleared and click OK.

TO DISABLE INDESIGN 1.5.2 COLOR MANAGEMENT WHEN IMPORTING IMAGES

1 Choose Place from the File menu.

The Place dialog box appears.

2 Select the Show Import Options option.

3 Select the file that you want to import and click Place.

4 Choose Color Settings from the option menu. Make sure that the Enable Color Management 
option is cleared and click OK.
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Selecting options when printing

You can use the standard Color Server printer driver interface to select print options 
from InDesign.

TO SET PRINT OPTIONS FROM THE WINDOWS VERSION OF INDESIGN 2.0.1

1 Choose Print from the File menu.

2 Choose the Color Server from the Printer menu.

3 Click Setup.

The Windows Print dialog box appears.

4 Click Properties.

5 Click the Fiery Printing tab in the dialog box that appears.

The standard printer driver interface for the Color Server appears.

6 Select the desired print options.

For information about setting ColorWise print options, see Color Printing.

7 Click Print.
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TO SET PRINT OPTIONS FROM THE MAC OS VERSION OF INDESIGN 2.0.1

1 Choose Print from the File menu.

2 Choose the Color Server from the Printer menu.

3 Click Printer.

The AdobePS Print dialog box appears.

4 Choose Printer Specific Options.

The Color Server print options appear.

5 Select the desired options.

For information about setting ColorWise print options, see Color Printing.

6 Click Print.
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TO SET PRINT OPTIONS FROM THE WINDOWS VERSION OF INDESIGN 1.5.2

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose the Color Server from the Name menu.

3 Click Properties.

4 Click the Fiery Printing tab in the dialog box that appears.

The standard printer driver interface for the Color Server appears.

5 Select the desired print options.

For information about setting ColorWise print options, see Color Printing.
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TO SET PRINT OPTIONS FROM THE MAC OS VERSION OF INDESIGN 1.5.2

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose the Color Server from the Printer menu.

3 Choose Printer Specific Options.

The Color Server print options appear.

4 Select the desired options.

For information about setting ColorWise print options, see Color Printing.
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Adobe PageMaker 7.x and 6.5 for Mac OS and Windows 
The Mac OS and Windows versions of PageMaker 7.x and 6.5 are essentially the same. 
The illustrations in this section show only the Windows version, except where differences 
exist between the two versions.

Windows version requirement

To use the Windows version of PageMaker 6.5, make sure that a copy of the Color Server 
PPD file is in the following folders:

• PM65\RSRC\USENGLSH\PPD4

• Windows\System

For information about installing this file, see your PageMaker documentation.

Installing the printer description files for Windows

The User Software CD contains printer description files for popular Windows applications. 
Adobe Pagemaker 6.5 and 7.x do not support automatic installation of printer description 
files from the Printers or Printers and Faxes Control Panel. To make the Color Server available 
in the Print and Page Setup dialog boxes of this application, copy printer description files to 
the appropriate location.

TO COPY THE PRINTER DESCRIPTION FILES

1 On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. Select the folder that 
corresponds to the system you are using.

For Windows 98/Me, select English\Prntdrvr\Ps_drvr\Win_9x_ME.

For Windows NT 4.0, select English\Prntdrvr\Ps_drvr\Win_NT4x.

For Windows 2000, select English\Prntdrvr\Ps_drvr\Win_2000.

For Windows XP/Server 2003, select English\Prntdrvr\Ps_drvr\Win_XP.

2 Copy the printer description file for your Color Server to the appropriate location.

For PageMaker 6.5, copy the printer description file to \PM65\RSRC\USENGLSH\PPD4.

For PageMaker 7.x, copy the printer description file to \PM7\RSRC\USENGLSH\PPD4.



MANAGING COLOR IN PAGE LAYOUT APPLICATIONS 52

PageMaker color settings

We recommend that you use ColorWise color management rather than the CMS options 
built into Adobe PageMaker. 

NOTE: Do not use both systems for the same print job. 

TO DISABLE PAGEMAKER COLOR MANAGEMENT 

1 Choose Preferences > General from the File menu.

2 Click CMS Setup.

3 Choose Off from the Color Management menu.

4 Click OK, and then click OK again to close the dialog boxes. 

TO DISABLE COLOR MANAGEMENT FOR A BITMAPPED IMAGE

1 Select the bitmapped image in the document.

2 Choose Image > CMS Source from the Element menu.

3 Choose None from the This Item Uses menu and click OK.
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Importing images

All RGB images placed in a document are affected by your RGB Source and Rendering Style 
settings. For best results with placed images, use the instructions in “Working with imported 
images” on page 29.

Selecting options when printing

All print settings are specified from the various Print dialog boxes in PageMaker 7.x or 6.5. 

NOTE: The Print dialog box for PageMaker differs from the Print dialog box for other 
applications that print to the Color Server. Follow the instructions in this section rather than 
the print instructions in Color Printing.

TO SET PRINT OPTIONS WHEN PRINTING FROM PAGEMAKER

1 Choose the Color Server printer description from the PPD menu in the Print Document 
dialog box.

2 Click Options.

3 Choose Normal from the “Send image data” menu in the Print Options dialog box and 
click Features.

To ensure that TIFF images print at their full resolution, do not choose the Optimized 
Subsampling default from the Send image data menu.
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4 If a document contains RGB placed images or colors defined in RGB that will not be separated 
to process colors, choose RGB Source and Rendering Style settings in the Print Features 
dialog box.

If the document contains PANTONE colors, choose the appropriate Spot Color 
Matching setting. 

5 Click Print from any of the PageMaker dialog boxes to send the job to the Color Server. 

Using optional Color Management from PageMaker

If you have additional color management requirements not offered by ColorWise, such as 
managing color on devices not controlled by the Color Server, consider using the PageMaker 
color management features. For more information, see your PageMaker documentation.
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QuarkXPress 5.x and 4.x for Mac OS and Windows

Importing images

With the exception of RGB images that are saved in EPS format or use Quark PrintRGB 
XTension, QuarkXPress converts all RGB data into CMYK, even when Quark CMS 
XTension is disabled.

Only RGB images saved in EPS format are affected by RGB Source and Rendering Style 
settings. For best results with placed images, follow the instructions in “Working with 
imported images” on page 29.

Selecting options when printing

The following procedure provides instructions on printing files to the Color Server.
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TO SET PRINT OPTIONS IN QUARKXPRESS 5.X OR 4.X

1 Choose the Color Server printer description name from the Printer Description menu in the 
Print dialog box.

2 If the document contains PANTONE colors, choose the appropriate Spot Color 
Matching setting. 

For information about setting print options, see Color Printing.

Mac OS
1 Choose the Color Server
2 Choose an output paper size
3 Click to specify printer 

settings

Windows
1 Choose the Color Server
2 Choose the Color Server 

printer description
3 Click to specify device 

settings

1
2

3

1

2

3
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Optional Color Management from QuarkXPress

If you have additional color management requirements not offered by ColorWise, such as 
managing color on devices not controlled by the Color Server, consider using the 
QuarkXPress color management features. For more information, see your QuarkXPress 
documentation.

For QuarkXPress 4.02, consider using Quark CMS XTension. These features allow advanced 
users to control RGB to CMYK color conversions. If you plan to use these features, make sure 
that Quark CMS XTension is installed before starting QuarkXPress. If it is not installed, use 
the Quark XTensions Manager to install it. For instructions, see your QuarkXPress 
documentation.

NOTE: Quark CMS converts RGB TIFF, JPEG, and PICT images to CMYK before sending 
color data to the Color Server. RGB Source and Rendering Style settings have no effect on 
this data unless you use Quark PrintRGB XTension, which outputs RGB TIFF image files 
without converting them to CMYK.

QuarkXPress 3.32 for Mac OS and Windows 
Before starting QuarkXPress 3.32, make sure the EfiColor XTension is not loaded in the 
XTensions folder. EFICOLOR profiles are not currently provided with Color Server 
products. Without the correct EFICOLOR profile, the EfiColor XTension cannot perform 
color conversions on placed images.

Windows version requirement

For the Windows version of QuarkXPress, make sure a copy of the Color Server PPD file is in 
the \XPRESS\PDF folder. 

Importing images

All RGB images placed in a document are affected by your RGB Source and Rendering Style 
settings. For best results with placed images, follow the instructions in “Working with 
imported images” on page 29. 

Selecting options when printing

The following procedure provides instructions on printing files to the Color Server.
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TO SELECT PRINT OPTIONS IN QUARKXPRESS 3.3

1 Choose the Color Server printer description from the Printer Type menu in the Page Setup 
(Mac OS) or Printer Setup (Windows) dialog box.

2 If a document contains RGB-placed images or RGB colors that QuarkXPress will print without 
converting to CMYK, choose RGB Source and Rendering Style settings. 

If the document contains PANTONE colors, choose the appropriate Spot Color 
Matching setting. 

For information about setting print options, see Color Printing.

Mac OS
1 Choose the Color Server
2 Choose an output paper size
3 Choose Binary 1

2

3

Windows
1 Choose an output paper size
2 Choose the Color Server
3 Choose Binary

1

2

3
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MANAGING COLOR IN ILLUSTRATION APPLICATIONS

You can print directly from an illustration application or use it to create and save files that will 
be imported into a page layout document. To print from an illustration application, use the 
printer driver and print settings recommended in Color Printing. As a general rule, use the 
EPS file format when saving files with an illustration application. When an EPS file is 
imported into another application, the color information in the imported image is not 
changed by the application into which it is imported.

Before printing from illustration applications, make sure that the appropriate PostScript 
printer driver and the Color Server PPD are installed on your computer, as described in 
Printing from Windows or Printing from Mac OS. This chapter provides instructions for using 
Adobe Illustrator, Macromedia FreeHand, and CorelDRAW for Windows and Mac OS.

NOTE: This manual provides instructions for printing composites only. For information about 
printing color separations, see the documentation that accompanies your application.
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Adobe Illustrator for Windows and Mac OS 
The following sections provide guidelines for working with Adobe Illustrator versions 10.x 
and 9.x.

Note about color models in Adobe Illustrator

In Illustrator, you can set the Document Color Mode to either RGB Color or CMYK color. 
All elements in that file are created in that color model. When you print the file, the data is 
sent to the Color Server in the color model that you specified.

Illustrator color settings

Illustrator uses a sophisticated color management system that can handle both RGB and 
CMYK colors for a variety of color-managed workflows. By customizing color settings, you 
specify the amount of color management you want to use while working in Illustrator. These 
color settings include the following:

Working spaces: Default color spaces to use when working with RGB and CMYK 
documents. ICC color profiles describe the gamut and color characteristics of these working 
spaces.

Color management policies: Instructions that tell Illustrator what to do when it encounters 
color data from a color space other than the specified working space.
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Specifying print options

The following procedure outlines the recommended color settings for Illustrator in a 
Color Server workflow.

TO SPECIFY COLOR SETTINGS

1 Choose Color Settings from the Edit menu.

The Color Settings dialog box appears.

2 Select Advanced Mode.

In Advanced Mode, a more extensive list of options is displayed.

3 Choose the desired working space profile for each mode in the Working Spaces area.

Use the following guidelines for specifying working spaces:

• For RGB, choose EFIRGB. This profile represents the default RGB color space used by the 
Color Server. New RGB documents you create in Illustrator will use this working space.

• For CMYK, choose a profile that describes your target press (such as SWOP) if you are a 
prepress user. If you are an office user printing final output, choose an output profile that 
describes the device connected to the Color Server. To use a device-specific output profile, 
upload the profile from the Color Server to your computer (see Color Printing). New 
CMYK documents you create in Illustrator will use the specified working space.
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4 Choose policies for handling documents without embedded profiles or with embedded 
profiles that differ from the working space in the Color Management Policies area.

Choose Off from the RGB and CMYK menus. This option discards the original profile 
embedded in a document if it differs from the specified working space.

In the Profile Mismatches area, select the Ask When Opening option. This option displays an 
alert message that allows you to override the specified policy behavior (Off ) when opening 
documents or importing color data.

5 Choose settings for converting between color spaces in the Conversion Options area.

Choose Adobe (ACE) from the Engine menu to use the built-in color management engine 
for Illustrator.

Choose a rendering intent from the Intent menu that will optimize the color quality of the 
conversion. For information about choosing the rendering intent, see your Illustrator 
documentation. 

Select the Use Black Point Compensation option to optimize the quality of color conversions.

6 Click Save to save the current group of color settings.

The Save dialog box appears. 

7 Name the settings file, accept the default saved location, and click Save.

You can switch to your saved settings at any time by choosing the group name from the 
Settings menu at the top of the Color Settings dialog box.

Saving files for importing into other documents

When saving files in Illustrator for importing into other types of documents, use the EPS file 
format. Illustrator can save color information in both RGB and CMYK. The ColorWise RGB 
Source and Rendering Style settings affect color output of RGB artwork saved in Illustrator 
EPS and imported into other kinds of documents (even when both RGB and CMYK artwork 
exists in the same file). In the case of Illustrator files imported into Photoshop, however, 
vector data from the Illustrator file is rasterized into bitmaps in Photoshop, and the final color 
space of the bitmap data is determined by the color mode you set in Photoshop.
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Specifying print options

The following procedure explains how to set print options when printing a document from 
Illustrator to the Color Server.

TO SET PRINT OPTIONS IN ILLUSTRATOR

1 Choose Print from the File menu in Illustrator.

The Print dialog box appears.

2 For the Windows version of Illustrator, specify appropriate print options.

• Choose the Color Server device from the Name menu.

• Choose Composite from the Output menu.

• Choose Level 3 from the PostScript menu. If you encounter problems, you can also use 
Level 2.

Illustrator 10.x for Windows
1 Select the device name
2 Choose Composite
3 Click Properties to set 

print options

1

2

3
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3 For the Mac OS version of Illustrator, specify appropriate print options.

• Choose the Color Server device from the Printer menu.

• Choose Adobe Illustrator from the option menu below the Printer menu.

• Choose Composite from the Output menu.

• Choose Level 3 from the PostScript menu. If you encounter problems, you can also use 
Level 2.

Illustrator 8.x and 9.x 
for Windows
1 Select the device name
2 Choose Composite
3 Choose PostScript Level 2 

or 3
4 Click Properties to set 

print options

1

2

3

4

Illustrator 10.x for Mac OS
1 Choose Composite

1
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4 If necessary, click Properties (Windows) or choose Printer Specific Options from the option 
menu (Mac OS) and choose RGB Source and Rendering Style settings for the Color Server. 

You only must specify these settings if you have a CMYK document containing placed RGB 
images, or an RGB document in Illustrator 9.x. In all other cases, colors remain unaffected by 
the settings. 

5 If the document contains PANTONE-named colors, choose the appropriate Spot Color Matching 
setting. 

For information about setting additional ColorWise print options, see Color Printing.

Using Illustrator color management

If you have additional color management requirements not offered by ColorWise, such as 
managing color on devices not controlled by the Color Server, consider using the Illustrator 
color management features. For more information, see your Illustrator documentation.

Illustrator 8.x and 9.x 
for Mac OS
1 Choose Composite
2 Choose PostScript Level 3 1 2
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FreeHand 10.x, 9.x, and 8.x for Windows and Mac OS 
The information in this section applies to both the Windows and Mac OS versions 
of FreeHand. Only Mac OS dialog boxes are shown, but the information and instructions are 
identical for the Windows version.

Setting FreeHand color settings

When using ColorWise color management, turn off the FreeHand color 
management features.

TO DISABLE COLOR MANAGEMENT IN FREEHAND

1 Choose Preferences from the File menu.

2 Click the Colors category in the Preferences dialog box.

3 Choose None for the type of color management.

Defining colors

Any colors defined in FreeHand are sent to the device in CMYK, even those defined using 
other color models. For best results, use the color definition methods described on page 25.

You can control the conversion of RGB colors defined in FreeHand by specifying settings in 
the Preferences dialog box under the Colors category, or choosing Color Management from 
the FreeHand menu on the Print dialog box.

1 Click Colors to access the 
color management settings

1
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Importing images

A number of file types can be imported into FreeHand, but once imported, all are treated as 
EPS images, TIFF images, or editable paths. For details, see your FreeHand documentation.

When you import an EPS image into a document, FreeHand inserts a link to the image rather 
than embedding the original file, resulting in a smaller file size. If the image is a CMYK EPS 
file, the colors print just as they would from the originating application. 

NOTE: Before placing a CMYK EPS file, be sure the file was saved with Desktop Color 
Separation (DCS) set to Off. If the file was saved with DCS activated, FreeHand prints 
composites of the image at the low resolution used for screen viewing.

All RGB images placed in a document are affected by your RGB Source and Rendering Style 
settings in the PPD. For best results with placed images, follow the instructions in “Working 
with imported images” on page 29.

Saving files for importing into other documents

When saving files in FreeHand for importing into other types of documents, use the EPS file 
format. FreeHand saves all color information in CMYK. The RGB Source and Rendering 
Style print options have no effect on the color output of RGB artwork saved in FreeHand and 
imported into other types of documents. In the case of FreeHand files imported into 
Photoshop, however, vector data from the FreeHand file is rasterized into bitmaps in 
Photoshop, and the final color space of the bitmap data is determined by the color mode you 
set in Photoshop.
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Specifying print options

The following procedure explains how to set print options when printing a document from 
FreeHand to the Color Server.

TO SET OPTIONS WHEN PRINTING FROM FREEHAND

1 Select the Use PPD option in the Print dialog box.

2 Choose Normal from the Print setting menu. 

• If the Use PPD option is selected, a plus sign (+) appears in front of the word “Normal.”

• If the model name for your Color Server is not displayed, click the button labeled “…” 
and choose the appropriate Color Server model from the menu that appears. 

1 Choose Normal
2 Click to access 

FreeHand Print Setup
3 Click to select a printer 

description 
(Name appears at right)

1 2
3
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3 To use ColorWise color management features, choose Output Options from the File menu.

The Output Options dialog box appears.

4 Make sure that the “Convert RGB to process” option is cleared. 

If this option is selected, FreeHand color management settings are used to convert RGB colors 
and RGB TIFF, PICT, and JPEG images to CMYK.

5 If a document contains placed RGB images, choose RGB Source and Rendering Style settings. 

With the exception of placed RGB images, these settings have no effect on colors printed with 
FreeHand. If the document contains PANTONE-named colors, choose the appropriate Spot 
Color Matching setting when you print the document. 

For information about other FreeHand print options, see your FreeHand documentation.

Optional color management in FreeHand

If you have additional color management requirements not offered by ColorWise, such as 
managing color on devices not controlled by the Color Server, consider using the FreeHand 
color management features. For more information, see your FreeHand documentation.

1 Clear option to use ColorWise 
color management

1
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CorelDRAW for Windows and Mac OS 
The following sections describe the recommended color settings for CorelDRAW 9.x and 8.x.

Defining colors

Any colors defined in CorelDRAW 9.x for Windows or CorelDRAW 8.x for Mac OS are sent 
to the device in CMYK, even those defined using other color models. For best results, use the 
color definition methods described in “Using color matching tools with PostScript 
applications” on page 25.

You can control the conversion of RGB colors defined in CorelDRAW by specifying settings 
in the Color Management dialog boxes. On Windows computers, the Color Management 
dialog boxes are located in Tools > Color Management. On Mac OS computers, the Color 
Management functions are located in Edit:Preferences:Global.

NOTE: If you do not want to use color management in CorelDRAW, choose None from the 
composite printer menu under Color Management/Profiles. Do not select options under 
Color Management and Color Management General.

Importing images

All RGB images placed in a document are affected by the RGB Source and Rendering Style 
settings. For best results with placed images, follow the instructions in “Working with 
imported images” on page 29.

Saving files for importing into other documents

When saving files in CorelDRAW for importing into other types of documents, use the EPS 
file format. CorelDRAW saves all color information in CMYK, so RGB Source and 
Rendering Style print options have no effect on color output of artwork saved with 
CorelDRAW and imported into other kinds of documents. In the case of CorelDRAW files 
imported into Photoshop, however, vector data from the CorelDRAW file is rasterized into 
bitmaps in Photoshop, and the final color space of the bitmap data is determined by the color 
mode you set in Photoshop.
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Specifying print options

This section explains how to set print options when printing from CorelDRAW to the 
Color Server.

NOTE: The following procedure uses Windows illustrations. The interface may vary 
depending on whether you are using Mac OS or Windows. Major differences are noted.

TO SET PRINT OPTIONS IN CORELDRAW

1 On Windows computers, click the General tab and then click Print.

2 Make sure that you have selected the correct device and printer description, and select the 
Use PPD option. 

3 Click Properties to specify ColorWise print options.

1 Print device name 
appears here

2 Printer driver/PPD name 
appears here

3 Click Properties to access 
ColorWise print options

1
2

3
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4 On Mac OS computers, click Printer in the General Print dialog box to select the device and 
print options.

To use ColorWise color management, make sure that the “Use color profile” option on the 
Misc tab of the Print dialog box is cleared. If this option is selected, CorelDRAW color 
management settings are used to convert RGB colors and images to CMYK.

5 If a document contains placed RGB images, choose RGB Source and Rendering Style settings 
for your device.

With the exception of placed RGB images, these settings have no effect on colors printed with 
CorelDRAW. 

6 If the document contains PANTONE-named colors, choose the appropriate Spot Color Matching 
setting.

Optional color management in CorelDRAW

If you have additional color management requirements not offered by ColorWise, such as 
managing color on devices not controlled by the Color Server, consider using the 
CorelDRAW color management features. For more information, see your CorelDRAW 
documentation.

1 Clear this option to use 
ColorWise Color Management

1
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DESKTOP COLOR PRIMER

This chapter covers concepts that are basic to printing in color, including:

• Properties of color

• Printing techniques

• Effective use of color

• Raster images and vector graphics

• File optimization for processing and printing

If you are already familiar with color theory and digital color printing, proceed to 
“Optimizing files for processing and printing” on page 87 for information about optimizing 
files for printing.
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The properties of color
This section introduces concepts that are basic to color theory. You will encounter some of 
these concepts (such as hue, saturation, and brightness) when you work with color in 
applications; others provide useful background information. Color is a complex topic, so 
consider this a starting point for experimentation and further research.

The physics of color

The human eye can see electromagnetic radiation at wavelengths between 400 nanometers 
(purplish blue) and 700 nanometers (red). This range is called the visible spectrum of light. 
We see pure spectral light as intensely saturated or pure colors. Sunlight at midday, which we 
perceive as white or neutral light, is composed of light from across the visible spectrum in 
more or less equal proportions. Shining sunlight through a prism separates it into its spectral 
components, resulting in the familiar rainbow of colors illustrated in the following figure.

Like the sun, most light sources we encounter in our daily environment emit a mixture of 
light wavelengths, although the particular distribution of wavelengths can vary considerably. 
Light from a tungsten light bulb, for example, contains much less blue light than sunlight. 
Tungsten light appears white to the human eye, which, up to a point, can adjust to the 
different light sources. However, color objects appear different under tungsten light than they 
do in sunlight because of the different spectral makeup of the two light sources.

The mixture of light wavelengths emitted by a light source is reflected selectively by different 
objects. Different mixtures of reflected light appear as different colors. Some of these mixtures 
appear as relatively saturated colors, but most appear as grays or impure hues of a color.
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CIE color model

In the 1930s, the Commission Internationale de l’Eclairage (CIE) defined a standard color 
space, a way of defining colors in mathematical terms, to help in the communication of color 
information. This color space is based on research on the nature of color perception. The 
following CIE chromaticity diagram is a two-dimensional model of color vision. The arc 
around the top of the horseshoe encompasses the pure, or spectral, colors from blue-violet to 
red. Although the CIE chromaticity diagram is not perceptually uniform, some areas of the 
diagram seem to compress color differences relative to others, it is a good tool for illustrating 
some interesting aspects of color vision.

By mixing any two spectral colors in different proportions, we can create all the colors found 
on the straight line drawn between them in the diagram. It is possible to create the same gray 
by mixing blue-green and red light or by mixing yellow-green and blue-violet light. This is 
possible because of a phenomenon peculiar to color vision called metamerism. The eye does 
not distinguish individual wavelengths of light. Therefore, different combinations of spectral 
light can produce the same perceived color. 

Purple colors, which do not exist in the spectrum of pure light, are found at the bottom of the 
diagram. Purples are mixtures of red and blue light—the opposite ends of the spectrum. 

Hue, saturation, and brightness

A color can be described in terms of three varying characteristics, called the HSB color model: 

• Hue: Tint (the qualitative aspect of a color—red, green, or orange)

• Saturation: The purity of the color

• Brightness: Relative position between white and black
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While the CIE chromaticity diagram illustrated earlier conveys hue and saturation, 
a three-dimensional color model is required to add the brightness component, as illustrated in 
the following figure.

Many computer applications include dialog boxes in which you choose colors by 
manipulating hue, saturation, and brightness. For example, some applications use a color 
picker that can be reconfigured according to your preference (as illustrated in the following 
figure).

Brightness

Saturation
Hue
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Additive and subtractive color systems

Color devices used in desktop publishing and printing simulate the range of visible colors 
using a set of primary colors that are combined to create other colors. There are two methods 
for creating a range of colors from a set of primary colors. Computer monitors and scanners 
are based on the additive color model. Printing technologies, including the Color Server and 
offset presses, are based on the subtractive color model.

Additive (RGB) color

Color devices that use the additive color model create a range of colors by combining varying 
amounts of red, green, and blue light. These colors are called the additive primaries 
(illustrated in the following figure). White is created by adding the maximum amount of red, 
green, and blue light available. Black occurs wherever all three colors are absent. Grays are 
created by adding equal amounts of all three color together. Combining varying amounts of 
any two of the additive primaries creates a third, saturated hue.
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A familiar device that is based on this color model is the computer monitor, illustrated in the 
following figure. Monitors have red, green, and blue phosphors that emit varying amounts of 
light to display a given color. Scanners create digital representations of colors by measuring 
their red, green, and blue components through colored filters.

Subtractive (CMY and CMYK) color

The subtractive color model is the basis for color printing, color photographic prints, and 
transparencies. While the additive color model simulates the visible spectrum of color by 
adding light of three primary hues, the subtractive color model starts with a “white” or neutral 
light source containing light of many wavelengths. Inks, toners, or other colorants are used to 
selectively absorb (subtract) certain wavelengths of light that otherwise would be reflected or 
transmitted by the media in use. 

The subtractive primaries are cyan, magenta, and yellow; they absorb red, green, and blue 
light, respectively (as illustrated in the following figure). Combining any two subtractive 
primaries creates a new color that is relatively pure or saturated. For example, you can make 
red by combining magenta and yellow, which absorb green and blue light, respectively. White 
occurs when no colorant is applied. In theory, combining all three subtractive primaries yields 
black, but due to deficiencies of cyan, magenta, and yellow colorants, combining these three 
primaries actually yields a muddy brown. Black colorant is added to compensate for the 
deficiencies of cyan, magenta, and yellow colorants. Consequently, color printing uses four 
process colors: Cyan, Magenta, Yellow, and blacK (CMYK). The use of black toner produces 
rich, solid blacks and allows for improved rendering of black text.
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Understanding color gamut
Different color reproduction techniques have different color capabilities, or gamuts. Color 
transparency films have comparatively large gamuts, as do color monitors. The color gamut 
that can be produced using process inks or CMYK toners on paper is smaller. This is why 
some colors that can be displayed on a color monitor, especially bright saturated colors, 
cannot be reproduced exactly by your Color Server, nor can they be reproduced on a press 
using process colors. Moreover, different printers have different gamuts. Some colors your 
printer can produce cannot be reproduced on an offset press, and vice versa. The following 
figure illustrates this concept of differing gamuts.

You must account for the gamut of your printer when designing on a color monitor. When 
printed, colors that fall outside the printer gamut are “mapped” to printable colors. This 
process, referred to as gamut mapping, takes place when color data is converted or adjusted 
to meet the gamut requirements of a printer. 

The Color Server is specially designed to perform gamut mapping at high speed with 
high-quality results. It provides these color management features automatically, using either 
built-in default settings or settings you select for a particular print job. For added flexibility, 
you can also use the Color Server color management system in combination with the color 
management systems on Windows and Mac OS computers.

1 Color transparency film
2 RGB monitor
3 Offset press (white)
4 Other print device

1

2

3

4
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Printing techniques
Until recently, most color printing was done on printing presses using one of several printing 
techniques, such as offset lithography, flexography, or gravure. All traditional printing 
techniques require lengthy preparation before a press run can take place. Short-run color 
printing, including Color Server printing, eliminates most of this preparation. By 
streamlining the process of color printing, the Color Server makes short print runs 
economically feasible.

In contemporary offset lithographic printing, digital files from desktop computers are output 
to an imagesetter, which creates film separations. The film is used to make a prepress proof, 
which is an accurate predictor of the final print job and allows you to make corrections before 
going to press. Once the proof is approved, the printer makes plates from the film and runs 
the print job on the press. 

With the Color Server, you simply print the file. The Color Server processes the PostScript 
information in the file and sends four bitmaps (one each for cyan, magenta, yellow, and 
black) to the printer. The ease of Color Server printing makes possible experimentation that 
would be too costly on a press, allowing unlimited fine-tuning of color and design elements.

Halftone and continuous tone devices

Halftoning is used in offset printing to print each process color at a different intensity, 
allowing millions of different colors to be reproduced using only the four process colors. 
Depending on the required intensity of a given color, toner is placed on paper in dots of 
different size. The grid of dots used for each toner color is called a screen. Halftone screens are 
aligned to unique angles designed to eliminate interference patterns called moiré that can 
arise with halftoning. 

Some color printers are commonly referred to as continuous tone (contone) devices. They do 
not use traditional halftone screen patterns and angles. Contone devices are capable of varying 
the intensity of individual dots. 

Even if your color printing is done exclusively on the Color Server, you will encounter 
concepts from offset printing if you use high-end graphics applications. For example, color 
controls in illustration applications, such as Adobe Illustrator, are geared toward specifying 
color for offset printing using process and spot colors. Many applications allow you to specify 
the screening used for each printing plate. 
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Using color effectively
The ability to print in color can greatly increase the effectiveness of your message, whether 
you are printing a presentation or newsletter (short-run printing), or proofing an ad concept 
that will later be printed on a press (color proofing). Some potential benefits of using color 
include:

• Conveying information rapidly by using color cues

• Making use of the emotive aspects of different colors

• Increasing impact and message retention 

Color can also be a source of distraction and discord if it is used poorly. This section outlines 
some guidelines and concepts to consider as you approach designing color materials.

General guidelines

To create successful color materials, consider the following:

• Use color to aid comprehension, rather than applying colors indiscriminately. 
In presentations, graphs, and charts, use color to highlight patterns and 
emphasize differences. 

• Use color sparingly. In general, fewer colors work better than many colors.

• Use red as an accent color. Red is particularly effective when used in otherwise 
monochromatic materials.

• Consider the tastes of your target audience when choosing colors. 

• Keep a file of printed color pieces that appeal to you or strike you as effective. Refer to it 
for ideas when designing your own documents.
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Color wheel

A color wheel like the one in the following figure is a helpful tool for understanding the 
interrelation of colors. The colors on one side of the color wheel, from magenta to yellow, 
appear to most people to be warm colors, while those on the other side, from green to blue, 
appear to be cool. The distance between two colors on the color wheel can help predict how 
they will appear when seen side by side.
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Colors opposite one another on the color wheel are called complements (see example a in the 
following figure), and create a striking contrast side by side. This can be the basis for a bold 
graphical design, but it is an effect you should use with discretion, since it can be visually 
fatiguing. Other bold combinations to consider are split complements—a color and the two 
colors adjacent to its complement (example b)—and triads (three colors evenly spaced on the 
color wheel (example c). Colors adjacent to one another on the color wheel result in subtle 
harmonies.

The color wheel simplifies color relationships for the purpose of clarity, showing only 
saturated or pure colors. Adding the myriad variations of each hue to the palette (more or less 
saturated, darker, or lighter) creates a wealth of possibilities. Taking a pair of complements 
from the color wheel and varying the saturation and brightness of one or both colors produces 
a very different result from the pure complements. Combining a light tint of a warm color 
with a darker shade of its cooler complement often gives pleasing results. Combining a darker 
shade of a warm color with a light tint of its cooler complement produces an unusual effect 
that may appeal to you.

Once you have mastered the concept of the color wheel, you have a good framework for 
experimenting with color combinations. Many books targeted at graphic designers show 
groups of preselected color combinations. Some are organized by themes or moods, and some 
are based on a custom color system, such as PANTONE. The more you develop a critical 
facility for judging color combinations, the more you will trust your own eye for color. For a 
selection of books about design, see the “Bibliography” on page 89.

a b c
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Color and text

It is not a coincidence that the overwhelming majority of text you see is printed in black on 
white paper. Text in black on white is highly legible and is not fatiguing to read for extended 
periods. For many color materials, using black text on a white background and confining 
color to graphic elements and headings is a good choice.

When used skillfully, color text can add flair to documents printed on paper. This technique is 
widely used in presentations. When using color text, avoid dazzling text and background 
combinations created from primary complements, especially red and cyan or red and blue. 
They are visually fatiguing and hard to read. Color text is more legible when distinguished 
from its background by a difference in lightness, for example, dark blue text on a light beige 
background. In addition, using many different colors in a string of text makes for a confused 
appearance and is hard to read. However, using a single highlight color is an effective way to 
draw the reader’s eye to selected words. For color text samples, see the following figure.

When using color text, keep in mind that small font sizes typically do not print in color with 
the same sharpness as in black. In most applications, black text prints exclusively in black 
toner, while color text usually prints with two or more toners. Any misregistration between 
the different toners on paper causes color text to lose definition. You can make test prints to 
find the smallest point size at which color text prints clearly. When using high-end graphics 
applications that allow you to specify color as percentages of cyan, magenta, yellow, black, you 
can create pure cyan or pure magenta text that prints with the same sharpness as black text. 
(Pure yellow text is extremely hard to read on anything but a dark or complementary 
background.)

STOP! STOP!

Exceptio probat
regulam de rebus
non exceptis.

De gustibus 
non est 
disputandum.
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Raster images and vector graphics
Two broad categories of artwork can be printed from a personal computer to a color printer: 
raster images and vector graphics.

A raster image, also referred to as a bitmap, is composed of a grid of pixels, each assigned a 
particular color value (as illustrated in example a in the following figure). The grid, when 
sufficiently enlarged, resembles a mosaic made from square tiles. Examples of raster images 
include scans and images created in painting or pixel-editing applications, such as Photoshop 
and Corel Painter.

The amount of data found in a raster image depends on its resolution and bit depth. The 
resolution of a raster describes the compactness of the pixels and is specified in pixels per inch 
(ppi). The bit depth is the number of bits of information assigned to each pixel. Black and 
white raster images require only one bit of information per pixel. Grayscale images require 8 
bits per pixel. For photographic quality color, 24 bits of RGB color information are required 
per pixel, yielding 256 levels of red, green, and blue. For CMYK images, 32 bits per pixel are 
required.

When printing raster artwork, the quality of the output depends on the resolution of the 
source raster. If the raster resolution is too low, individual pixels become visible in the printed 
output as small squares. This effect is sometimes called “pixelation.”

In vector graphics, picture objects are defined mathematically as lines or curves between 
points—hence the term “vector” (see example b). Picture elements can have solid, gradient, 
or patterned color fills. Vector artwork is created in illustration and drawing applications, such 
as Illustrator and CorelDRAW. Page layout applications, such as QuarkXPress, also allow you 
to create simple vector artwork with their drawing tools. PostScript fonts are vector-based, 
as well.

Vector artwork is resolution-independent. You can scale it to any size and resolution without 
danger of pixels becoming visible in printed output.

a b
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Optimizing files for processing and printing
The following sections provide information about how to create image files that produce 
the highest possible print quality while minimizing the processing time and disk space 
they require.

Resolution of raster images

While a 72-ppi raster image appears sharp on a monitor, the same image would likely appear 
pixelated when printed to the Color Server. Color printers are capable of much greater detail 
than computer monitors, and require correspondingly higher resolution image files. However, 
high-resolution files can be large and, therefore, cumbersome to transmit over a network, 
process for printing, store on disk, and edit. 

Beyond a certain threshold, a higher image resolution greatly increases file size while having a 
minimal effect on output quality. The optimal image resolution depends on the resolution of 
the final print device. Aim for the resolution that optimizes both file size and output quality.

The resolution of a raster image, along with its bit depth and physical dimensions, determine 
its file size. The following table shows the file sizes of color raster images at different 
dimensions and resolutions.

In this table, the shaded areas indicate that 200 ppi is typically the best trade-off between 
image quality and file size. However, higher resolutions (for example, 250 to 300 ppi) may be 
necessary for offset printing, when quality is of the utmost importance, or for images 
containing sharp diagonal lines.

To find the best image resolution for your purposes, make test prints of some raster artwork at 
different resolutions. Start with a high-resolution image (400 ppi) and save versions at 
progressively lower resolutions, down to 100 ppi, using a pixel-editing application, such as 
Photoshop. Always save a copy of the original high-resolution version, in case you must revert 
to it. The high-resolution data cannot be recreated from a lower resolution version. 

File size at

100 ppi 150 ppi 200 ppi 400 ppi 600 ppi

Image size RGB/CMYK RGB/CMYK RGB/CMYK RGB/CMYK RGB/CMYK

3"x 4" 0.4/0.5 MB 0.8/1.0 MB 1.4/1.8 MB 5.5/7.3 MB 12.4/16.5 MB

5"x7" 1.0/1.3 MB 2.3/3.0 MB 4.0/5.3 MB 16.0/21.4 MB 36.1/48.1 MB

8.5"x11" 2.7/3.6 MB 6.0/8.0 MB 10.7/14.3 MB 42.8/57.1 MB 96.4/128.5 
MB

11"x17" 5.4/7.1 MB 12.0/16.1 MB 21.4/28.5 MB 85.6/114.1 
MB

192.7/256.9 
MB
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Print the files and examine the output. You will likely begin to see a marked deterioration in 
output quality at resolutions below 200 ppi, while above 200 ppi the improvement may be 
very subtle. 

Raster images prepared for offset printing may need to be at higher resolutions than necessary 
for proofing on your Color Server.

Scaling

Ideally, each raster image should be saved at the actual size, and it will be placed in the 
document at the optimal resolution for the printer. If the image resolution is correct for the 
printer, there is no quality advantage to be gained by scaling an image to a percentage of its 
actual size. If you scale a large image to a percentage of its actual size, you incur unnecessary 
file transfer time, because the image data for the entire large image is sent to the printer. If an 
image is placed multiple times at markedly different sizes in a document, save a separate 
version of the image at the correct size for each placement.

If you must place an image at greater than 100% in a document, remember that the output 
image resolution is affected. For example, if you scale a 200 ppi image to 200%, the image is 
printed at 100 ppi.

100 ppi 200 ppi 300 ppi 400 ppi 500 ppi 600 ppi

Image resolution

Im
ag

e 
qu

al
it

y



BIBLIOGRAPHY 89

BIBLIOGRAPHY

Books

Adobe Print Publishing Guide. Adobe Press, 1998. ISBN: 1568304684

Blatner, David and Fraser, Bruce. Real World Adobe Photoshop 7. Berkeley: Peachpit Press, 
2002. ISBN: 0321115600

Bruno, Michael H., ed. Pocket Pal ®: A Graphic Arts Production Handbook. Eighteenth 
Edition. GATFPress, 2000. ISBN: 0883623382

Hunt, R.W.G. The Reproduction of Colour. Sixth Edition. Surrey: Fountain Press, 2002. ISBN: 
0863433685

Kieran, Michael. The Color Scanning Success Handbook. Toronto: DPA Communications 
Corp., 1997. (Out of print)

Kieran, Michael. Understanding Desktop Color, Second Edition. Berkeley: Peachpit Press, 1994.

Margulis, Dan. Professional Photoshop: The Classic Guide to Color Correction. John 
Wiley & Sons, 2002. ISBN: 0764536958

Miller, Marc D. and Zaucha, Randy. The Color Mac. Second Edition. Hayden Books, 1995. 
(Out of print)

X-Rite Color Guide and Glossary: Communication, Measurement, and Control for Digital 
Imaging and Graphic Arts. X-Rite Incorporated, 1999. (Available from X-Rite dealers or via 
the X-Rite web site, www.color.org <http://www.color.org/>.)

World Wide Web sites

International Color Consortium: www.color.org

Graphic Arts Information Network:
<http://www.gain.net/PIA_GATF/about_join/aboutgatf.html>

Seybold Seminars Online: www.seyboldseminars.com

Adobe Systems Incorporated: www.adobe.com

http://www.color.org
http://www.color.org
http://www.gatf.org
http://www.seyboldseminars.com
http://www.adobe.com




INDEX 91

A
accent color 82
additive color model 77
additive primaries 77
Adobe
Adobe (ACE) conversion option

Illustrator 62
Photoshop 36

Adobe Illustrator, see Illustrator
Adobe InDesign, see InDesign
Adobe Photoshop, see Photoshop

B
bit depth, of raster images 86, 87
bitmaps, see raster images
Blend RGB Colors Using Gamma, Photoshop 

setting 36
brightness 74, 75

C
charts, using color in 82
choosing color 16
CIE

chromaticity diagram 75, 76
color model 75

CIELAB color space 9
CMY color model 20
CMYK Color Reference 12, 25
CMYK EPS

FreeHand 67
Photoshop 42

CMYK simulation method 30
CMYK Simulation profile 30
color

accent color 82
additive model 77
CMY model 20
complements 84
controlling printing results 16
conversion by color management systems 10
custom color systems 24

defining in PostScript applications 27
HSB model 24, 75
HSL model 20, 24
HSV model 20
physics of 74
process colors 81
properties of 74
reference pages 12
RGB model 20, 24
split complements 84
spot colors 81
subtractive model 77, 78
subtractive primaries 78
swatch color matching 25
text 85
theory 74
triads 84
using effectively 82 to 85
wheel 83

color management
basics 9 to 10
ColorWise 11
Illustrator 60
monitor 19
QuarkXPress 57

color management system (CMS) 9
color matching systems, see custom color systems
color monitors, see monitors
color proofing 18
color space 75
color theory 74
color wheel 83
ColorSync 9
ColorWise 9, 11
Combine Separations, Photoshop 39
Commission Internationale de l’Eclairage, see 

CIE
complements, color 84
compression, JPEG 38, 39, 41, 42
computer monitors, see monitors
continuous tone devices 81

INDEX



INDEX 92

Conversion Options, Photoshop setting 36
Convert RGB to process, Freehand setting 69
CorelDRAW 70 to 72
CRDs

bypassing 22, 29
rendering intent 20

custom color systems 24, 84

D
defining color 27
Desaturate Monitor Colors By, Photoshop 

setting 36
device profiles 9
Document Color Mode, Illustrator 60
documentation 8

E
EFICOLOR

profiles 57
XTension 57

EFIRGB
Illustrator 61
Photoshop 35

embedded profile, Illustrator 62
Encoding, Photoshop setting 39
EPS (Encapsulated PostScript)

about 29
color accuracy 23, 32
defining colors 22
imported images 29
PostScript Color Management 41
with CorelDRAW 70
with FreeHand 67
with illustration applications 59
with Illustrator 62
with Photoshop 37

EPS CMYK
FreeHand 67
Photoshop 42

EPS RGB 41
Excel, see Microsoft Office

F
Fiery Graphic Arts Package 31
file size, of raster images 11, 87
flexography 81
font size, for color text 85
FreeHand 24, 66 to 69

G
gamma 10
gamut

mapping 80
of monitors 80
of photographic transparencies 80

GDI applications, using color in 20 to 24
Graphics Device Interface, see GDI
graphs, using color in 82
gravure 81

H
halftone screen 31
halftoning 81
HSB color model 24, 75
HSL color model 20, 24
HSV color model 20
hue, saturation, and brightness 74, 75

I
ICC profiles

about 35
included with user software 10

ICC standard for color management systems 9
illustration applications 59
Illustrator 24, 60 to 62
InDesign 44 to 50
International Color Consortium 9

J
JPEG 38, 39, 41, 42

L
light 74 to 75
line art, see vector images

M
Macromedia FreeHand, see FreeHand
metamerism 75
Microsoft Excel, see Microsoft Office
Microsoft Office 20 to 23
Microsoft PowerPoint, see Microsoft Office
Microsoft Word, see Microsoft Office
misregistration of colors 85
moiré 81
monitor color management 19
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monitors
color model 78
gamut of 80
phosphors 78

Multi-channel, Photoshop 43

N
named colors 24

O
office applications 17, 20 to 23
offset lithographic printing 81
offset press print jobs, workflow issues 18
offset press printing 81
on-demand printing 18
Output Options, FreeHand 69
output profile

color conversion 10
with office applications 23

P
page layout applications 44
PageMaker 24, 51 to 54
PageMaker, see PageMaker
painting applications 86
PANTONE

color system 24, 25
reference 12

phosphors 10, 78
photographic prints 78
photographic transparencies 78, 80
Photoshop

color management with 24
importing CorelDRAW data 70
using 33 to 43

Photoshop Multi-channel 43
physics of color 74
pixel-editing applications 86, 87
pixels in raster images 86
PostScript applications

color handling 24
using color in 24 to 32

PostScript Color Management, Photoshop 
option 38, 41

PostScript printer drivers 23
PowerPoint, see Microsoft Office
prepress proof 81
presentation print jobs, using color in 82
press simulation, see CMYK Simulation option

Print Space, Photoshop setting 40
printing

raster images 86
techniques 81

prism 74
process colors 25, 78, 81
Profile Mismatches

Illustrator setting 62
Profile, Photoshop setting 40
profiles, device 9
proofing

color 18
prepress 81

Q
Quark CMS XTension 57
QuarkXPress 24, 55 to 58
QuarkXPress color management 57
QuickDraw applications, using color in 20 to 24

R
raster images

about 86 to 88
bit depth 86, 87
file size 87
for offset press printing 88
printing 86
resolution 87 to 88
scaling of 88

registration of colors 85
rendering styles 20
RGB color model 20, 24
RGB Color Reference 12, 21
RGB EPS 41
RGB source color space, see source color space

S
saturation 74, 75
scaling of raster images 88
scanners 77, 78
screens, used in halftoning 81
Separations, printing with Photoshop 39
short-run printing 18
simulation, see CMYK Simulation option
source color space 10
spectral colors 75
spectral components of light 74, 75
split complements 84
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Spot Color Matching option
with Photoshop 43
with PostScript applications 26

spot colors 24, 25, 81
sRGB 35
subtractive color model 77, 78
subtractive primaries 78
sunlight 74
swatch color matching 25

T
text

font size 85
using color with 85

TIFF images
assigning ICC profiles to 29
preview 38
printing at full resolution 53
recommended for imported images 29, 37

tint 75
transparencies (photographic) 78, 80
triads 84

V
vector images 86
visible spectrum of light 74

W
white point 10
Windows Graphics Device Interface, see GDI 

applications
Word, see Microsoft Office
workflow, recommended 15
working space

Illustrator 60, 62
Photoshop 34
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